Working eLogger HMI with ISaGRAF SoftLogic in the
WP-8xx7, VP-2xW7 and XP-8xx7-CE6 PAC

Version of this paper is 1.01 released on Nov.25, 2009. by chun@icpdas.com

The “eLogger” is a HMI development tools developed by ICP DAS. It features with easy use and
friendly interface. The eLogger HMI can run with ISSGRAF SoftLogic in the WP-8xx7, VP-2xW7 and
XP-8xx7-CE6 (will be available).

The WP-8147/8447/8847, WP-8137/8437/8837 and VP-25W7/23W7 support eLogger in the following
driver version.
WP-8xx7: driver version 1.16 or later ver. VP-25W7/23W7: driver version 1.07 or later ver.

Download the latest PAC driver at http://www.icpdas.com/products/PAC/i-8000/isagraf-link.htm

This paper may be modified in the future to include more functions provided by the newer eLogger
version. User may visit the below web site to get the latest document and example programs.
Www.icpdas.com > FAQ > Software > [SaGRAF > FAQ-115 .
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1.1: Building A ISaGRAF SoftLogic Project

This sample project name is “el._01.pia” which can be downloaded at www.icpdas.com > FAQ >
Software > [SaGRAF > FAQ-115 . If user is familiar with the ISaGRAF programming, please restore
this “eL 01.pia” to the PC / ISaGRAF first. Then download it to the WP-8xx7 PAC. Then go to the
section 1.2 to learn more about building eLogger HMI pictures.

[EIS&GRLF - Froject Management _ | |:|| ﬂ

File Edit Project | Tool: Ophions Help

D |2
testl Libraries Common ~

demo_43 U A rchive - Projects x|
Reference el
Author : Wwhorkbench Archive
Date of creation : 20 |cr_ahul Al | 215%in Backup |
Version number :1 [S_shul ardehill
. . L CI_asm_ charl_2
Description : o ool Eiestare
u:r:mhuE test11 !
CI_Km kztl Claze
or_tmic_| wpac_tst —
CI_tin
cr_winl Help |
cr_wing
crl_win b
creation
derno_43
el 01 = V¥ Compress
—Archive location
D:ATERPY Erowse . !

If user is not familiar with ISaGRAF, then please follow steps listed in the section 1.1 .
(New beginner can refer to the Chapter 2 of the “ISaGRAF User's Manual” . The PDF file name are
“user_manual i 8xx7.pdf” and “user manual i 8xx7 appendix.pdf” burned in the below CD-ROM.
WP-8xx7 CD-ROM: \Napdos\isagraf\wp-8xx7\english manu\
VP-2xW7 CD-ROM: \Napdos\isagraf\vp-25w7-23w7\english manu\
or download at http://www.icpdas.com/products/PAC/i-8000/getting_started manual.htm )

If your PC hasn't installed the ISaGRAF software, then install it first. (You need to purchase at least
one pcs. of [SaGRAF-256 or ISaGRAF-32 software. Please refer to the “Ordering Information” at the
bottom of http://www.icpdas.com/products/PAC/i-8000/isagraf.-htm )

Then follow steps listed in the section 1.2 of the “ISaGRAF User's Manual” to install the “ICP DAS
utilities For [ISaGRAF”.
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1.1.1: Creating A New Project

Run ISaGRAF project software, then create a new project. Name it as “eL. 01 .

AI3aGRAF - Project Management
File Edit Project Tool: Options Help

Open Cl+0 i I = | 23 Trouble2 |
Belect project gronp ;l
JCronts nov project
Eename 1
Copyy Chel+C M ame: |E|__|:|1 |
Dielete
|0 configuration;
Upload project

| [hiome]

Eit

OF.

LCancel

]
Description
[
Then double click the project name to get into it.
3 ISaGRAF - Project Management 10| x|
File Edit Project Tools Ophions Help
BE DEMD ES| ¢ 0 — |2 mrouse
demo_43 SMS demo, Please declare your own phnlﬂ
trirt
elLogger + 1ZaGRAF j
Reference el 01 [
Author : [
Date of creation : 2009{1179
Yersion number 1 -15aGHAF 3.46
Description =
ICP DAS

ISaGRAF FAQ-115 Version 1.01




1.1.2: Declaring The ISaGRAF Project Variables

This example will use the following ISaGRAF variables

Name Type Attribution | NetWork Description
Addr.
Long 1 Integer Internal 1 To access to eLogger 's 32-bit Long Tag
Word 3 Integer Internal 3 To access to eLogger 's 16-bit Integer Tag
Word 4 Integer Internal 4 To access to eLogger 's 16-bit Integer Tag
Float 5 Real Internal 5 To access to eLogger 's 32-bit Float Tag
OUT 101 Boolean Output 101 Link to Ch.1 D/O of slot 1: I-87055W
OUT _102 Boolean Output 102 Link to Ch.2 D/O of slot 1: I-87055W
MI Boolean Internal 0
DIR Boolean Internal 0 Declared with an initial value “True”

Get into the “Dictionary” , then click “Integers/Reals” , then double click the blue area at below.

-- ISaGRAF - EL_01 - Prograx - 101 x|

File Make Pmoject Tool: Debmg Options Help

B HSX DEMm *Xis m§

Begin: M LD1
[ Dicthnary 2y ST

%, [SaGRAF - EL_01 - Global inte gersfreals

| File Edit Toolz Optionz Help
Ber | | & 0@ sxBd L8|

Booleans IntegersResls | Tiers | Messages | FB instances | Defined words |

=10 x|
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Name it as “Long_17, set Network Address as 1

Inte gerfReal ¥ariable x|

M arne: |Ln:|ng_1 | Mebwark Address: Always be Hexadecimal
format here.
Comment: |
Unit; | | Correersian: | [riore] il
—attibutes———— —Fomat
% Irteger | [ztandard] j|

T T Fed Cancel |

& Output kext |

(" Constant Initial swalue: | | -

 Fletain Previous |

Cirn: I:I Extended |

Then click “Store” . Then declare “Word 3” and “Word 4” by the same way. Set their NetWork
Address as 3 and 4 respectively.

_io/x]
File Edit Toolz Option: Help
| @00 e —x<Bd g

Booleans  IntegersResls ] Timers | Messages | FB instances | Defined words |
Mame Attrib. Addcdr Commert

[intermal integer] (D001

Then we got the following picture.

% ISaGRAF - EL_01 - Global inte gersfreals O] x|
File Edit Toolz Optons Help

| &0t e —x<md g

Booleans IMteoersReals | Timers | Messages | FB instances | Defined words |
Mame: Adttrib. Acldr. Cormmenit

o1
1003
noo4
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By the similar way to declare the “Float 5” . Set its format as “Real” and the Network Addr as 5.

Inte gerfReal Yariable x|
M arne: |F|'I'Elt_5 | Metwork, Address: E
Comrmert; | |
Urit: | | Corversion: | [rone) j|
—Afributes ——————— — Forrnat
i~ |nteger |[stanu:|ar|:|] j|
& [ Real LCancel |
" Dutput Mext |
" Canstant Initial wale: | | .
I Retain Previous |
Drirr: I:I Extended |

Then we got the following picture. To declare Boolean variables, please click “Booleans” first.

% ISaGRAF - EL_D1 - Global integersfreals -0 x|
File Edit Tool: Cphons Help

| | 8008 ~xBd| S|

IntegersReals ] Timers | Meszages | FB instances | Defined waords |
Acddr. Comment

Mame
Long 1

Word 3
Word 4
Float b
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By the similar way as former to declare “OUT 101" and “OUT 102 and “M1” . Set the attribution of
“OUT _101” and “OUT 102” as Output. Set their Network address as 101 and 102 respectively. While
set M1's attribution as Internal .

Boolean Variable Always be Hexadecimal

format here.
Mame: | [DUT_101 | Network Address: | 0085 |
Comment: | |
—Attributes———————— Yalues
Shore
" Internal Falze: | |
£ Input LCancel |
= = True; | |
* Output Mext |
" Constant [ set ta e at init
I~ Retain Previous |
S — |
It Extended

Then we got the following picture.

% [SaGRAF - EL_01 - Global booleans -0 x|
File Edit Toolz Option: Help

| | @ 00@e | =xBd &

E ]Integers.ﬂeals Timers | Mezzages | FB instances | Defined words |
Adtrik. Al Commenrit

Mame
OUT 101
OUT 102
M1

Always be Hexadecimal
format here.

Declare one more boolean variable “DIR” as below. Check the “set to true at init” .

Boolean ¥ariable x|
M ame: ||:'|H | Metwaork Address: :l
Comment; | |
—Attibutes—————————— Walues

[ 5o n]
= |nternal Falze: | |
T Input Cancel |
~ 3 True: | |
Outpuk Hewt |
™ Constant
T Retain Previouz |
o — |
i Extended
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1.1.3: Creating the Sample Ladder Diagram Program - LD1

After all variable declaration is finished, click “save” to save it and then exit the following window.

%, ISaGRAF - EL_01 - Global booleans | EI|_>{

File Edit Tool: Options: Help

| | & 00 G =B d| &

E"I"I'|Eﬂ|'l3]|r|tegers.ﬂeals| { ers|Messages|FEl instances|Defined WDrdSl
Attrib. Ay Commenit

ouT_10M 0083

ouT_102 D0&E

M1 i o0o

[irterrisl] 0aoo0

Diir
0000 [irternal] (falzetrus) [=TRELE]

Then create a new program as the following picture. Name it as “LD1”, select its language as “Quick
LD : Ladder Diagram” . Set the “Style” as “Begin: Main program” .

-=_I13aGRAF - EL_D1 - Programs =10 x|
File Make Pmoject Tool: Debmz Options:  Help

B HSE NE6 ¥ Xis o3 A2 %

| Create new program |

e x| —
Begin: LD1  (Lad
M arne: |LD'| |
Caomment: ! |
Language: | Guick LD : Ladder Diagram jl
Style: Begin: Main program jl
Ok % LCancel |
by

Then we got the following picture. Please double click the program name to get into it.
-+ I3aGRAF - EL_01 - Frograms O] x|
File Make Pmoject Tool: Debnz Options Help

B HSE BN 2 X nk| Lo
Begin: [iricy

Begin: LD1 (Ladder Diagram]
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We are going to create a “SYSTIM_R” function block to get the PAC 's Hour/Minute/Second . Click
“Block on the left” , then double click inside the block to select the “SYSTIM R”.

i I3aGRAF - EL_01:LD1 - Quick LD Program -10] x|

File Edit Toolz Options Help
BE XA HE | <BL bnt|aa=i g

F2:4HE F3:HE Fé: Gl | FE:-{H | Fs:ﬂ F7:iHF Fa: 150 | F8:—% tFa:m |

FY
Block on the left

5i# [SaGRAF - EL_01:LD1 - Quick LD Frogram -|O] x|
4 Bile Edit Tool: Option: Help

DA Yol e w<Ed knlQaasi g

F2: 9B F2:9HE Fib: T | FS:-(H | Fé:{HE F7: 60 Fa: gl | FS: —& fFa.Gm |

" j

pd
SME_GETS  Get message data & others - 0. j
IW SME_SEMD  Triger to send a new message — |
SMS_STS Get message sending status
SMS_TEST  Testif message coming or not Lancel
SERT zgjuare root
SR =et dominant bistable Info |

STACKINT stack of integers
STATIST statist calculation
STOP_APL  Stop 1SaGRAF project running
STP_DI= Dizable stepping motor autput
STP_EM Enable stepping motor autput
STP_EMZ Move stepping motor some step
STP_STS Get stepping output status
STR_ARY convett string to a byte array
STRE_REAL  Convett a string to a real val
SYSDAT R read Conker's system date
=YEDAT W write Conker's system date -
S read Conker! e time

-
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Double click on the right hand side of the “SS_” parameter to connect the “Word 3” on it.

i I5aGRAF - EL_01:LD1 - Quick LD Frogram =10 x|

File: Edit Tool: Cphons Help

DR XD HD <BL on Qa=i gl
F2:963 F2:3HE Fa: GJ | FE:H | Fé:{HE F7 3 Fa:lgl | Fo:—= fF .G |
=
SYSTIM_R
I eh eho i
HH_
hdhd_
zl
Scope: |[I3||:|I:|al] _ﬂ |||| Inteqer/F eal ﬂ
Boolean -
wiord_3
pos=34 | | \ Tirmer
eszage i
Float_& Program
Long_1 L function %

ord_4 !

H5i# [SaGRAF - EL_01:LD1 - Quick LD Frogram -0 x|
File Edit Toolz Oplons Help

BE XERA  HE <Bd br Qasi gl

F2: 963 F2:3HE Fab: G | FE:+(H | Fi:{HE F: i3 Fa:Inl | Fo:—= fFa.am |

- j

SYETIM_R
I en eno i
HH_
Pl _
S5 HWord_3 -
1] | LI_I

|p|:us=IZI,E
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We are going to generate a pulse True every second to the boolean variable “M1” . Move the cursor to
the below position under the block first.

g ISaGRAF - EL_01:LD1 - Quick LD Program

File Edit Tool: Option: Help
DR XA | HS «<Bd o QasiE
F2:dBE F2:9HE Fib: G | FS:-(H | Fé: {hg F7: 0 F: gl | F8: =& fF3.0m |

Block on the left

SYSTIM_R
en ena

{7

HH_

fh_

20 Word_3

-

Then double click on the left hand side of the “CYCLE” parameter to key-in “T#1s” .
Hig [SaGRAF - EL_01:LD1 - Quick LD Program

=10 x|

File Edit Tool: Options Help
DA XA HS «<Bd B Q=i &

F2:4HE F3:HE Fd: G | FE:-H | FE:{HE F7:1H3 F2: 150 | F8:—% tFa:E |

3

!
SYSTIM_R
I en eno |
HH_
hahd_
sz |ward_3 Soope | (Gilobal) = |||||
- [T#1s
BLIME
g RLIN Float_5
Long_1
ard_3
ard_4
pos=1 7
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Then move the cursor to the coil at right hand side of the block. Click “Coil / Contact type” several
time to select the “N” coil.

iz [SaGRAF - EL_01:L.D1 - Quick LD Frogram _|EI|5|
File Edit Toolz Optons Help
ba Xor He =B bk AR2HE &
F2. 96 F2:9HE Fie FE:CH | FE:{HE 7963 Fe: Ff-}b—-mm—l—‘
b | | ol | Coilicortact type
iy j
SYSTIM_R
I ar eno |
HH_
hahd_
25 ord_3
iy
BLIME
I R LM
T# s ey CLE
|pn:ns=4,5 |
Then double click on the “N” coil to connect the boolean variable “M1” on it.
g ISaGRAF - EL_01:L.D1 - Quick LD Program _|I:I|i|

File Edit Tool: Opton: Help
DR X2 He | <Bd bolaa=i g

+hEE

F2:4EE F3:iHE Fé: G | FE:-(H | Fe:{HE F7:3H3 Fa: I | F8:— tFam |

" j

SYSTIM_R
I [=1] enn |
HH_
MM
s Fword 3
™ %
BILIMK
I RN o]
T#1s—CYCLE \
|p|:us=4,E |
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x|
Scope: |[EI|:|I:|a|] j| ||||

|M-I Integera’H eal —
Tirmer (I
Meszage

Z1.0.8 Pragram

E0x11.3 C function -

20114

Z=1.1.5

ZOx1.1.6

EOR1.1.7

Z01.1.8

Chir

OuT_10 -

iz [SaGRAF - EL_01:L.D1 - Quick LD Frogram
File Edit Toolz Optons Help

F2: 4B

%|xfh|ﬂ-%§|%¢dlﬁﬂ”&&ﬁiiﬁlﬁl
=&

- Fit: Tl | FS:-(H | Fé: {3 F7: 60 Fa:lgl | Fo: —& fFa.Gm |

"
SYSTIM_F
I 2n 2na |
HH_
hdhd_
55 ord_3
!
BLIME
I RLIM 9]
T#1 sy CLE
pos=4 &
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1.1.4: Creating a Structured Text program - ST1

Create a ST program “ST1” as the following picture.

== JEaGRAF - EL_01 - Frograms - |EI|5|

File Make Project Tool: Debnz Ophtons Help

B HSE NEO ®Xie mk AEs
Begin: [rry
Create nesy program

New P X

Name: | (ST |
Comment: | |
Language: || 5T Structured Test ~|
Shyle: Beqin: Main program jl

ok ; ! Cancel |

Double click the program name to get into it.

-=_I5aGRAF - EL._01 - Programs - |I:I|5|
File Make Pmoject Tools Debng Optons  Help
BlESTEDE0] X ok fas]
Begin: [y LD

=N

|Elegin: ST1 (Structured Text)

Edit the following code.

if M1 then
if (Dir=True ) then
Word 4 :=Word 4+1; (* Counting up *)
else
Word 4 :=Word 4-1; (* Counting down *)
end if;
end if;;

if Word 4 <=0 then
Dir := True ; (* reach Min. value, change to counting up *)
end if;;

if Word 4 >=50 then
Dir ;= False ; (* reach Max. value, change to counting down *)
end if;;
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Then we got the following picture. Click “save” and then exit it.

s ISaGRAF - EL_01:8T1 - 5T program _|EI|€

File Edit Tool: Optionz Help

D& Y22 B <B4 B 8|
\

if M1 then
if € Dir=True » then C* Counting up *»
Word_ 4 := Yord 4 + 1 ;
else (* Counting down =
Uord 4 := Word_4 — 1 ;
end_1if
end_if :

* Convert to Counting up when reach min. value =)
if Word_ 4 <= 8 then

Dir == True ;
end_if :

* Convert to Counting download when reach max. value >
if Word_4 >= 58 then
Dir == False ;

end_if

1.1.5: Connecting The 1/0

We have declared two boolean variables with attribution “Output”. Their name are “OUT_ 101" and
“OUT _102” . To connect them to the physical I/O board (I-87055W in this example), please click the

I/0 connection” .

-=_.ISaGRAF - EL_D1 - Programs =10 x|

File Make Pmject Tool: Debug Option: Help

B SN DEN X @k 2as |

Bedin: [y LD

|Elegin: ST1 (Structured Text)

Double click the slot number “1” to insert the “i_ 87055 . (If find no “Equipments” > “i 87055, it
means the “ICP DAS Ultilities For ISaGRAF” has not installed. Please refer to section 1.2 of the

“ISaGRAF User's Manual” )
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s ISaGRAF - EL_01 - 1/0 connection -0l x|

File: Edit Tool: Ophtions Help
B eBR2n 03 FR| 8]

i_37005a; 8 CH. Thermiztar with Alarm -
8701 3a: 4 CH. BRTD [nput with Alarm
i_837017a; 8 CH. Analog [npuk with Alarm
i_87018a: 8 CH. Themmocouple with Alarmn Cancel
i_87019a: 8 CH. Thermocouple with Alarm
i_87040c: 32 CH. D/ & Cnit [Mawe. 100Hz)
i_87046c: 16 CH. D/ & Cnit [Max. 100Hz)

i_ 87057 16 CH. D/ & Cnt [Max. 100Hz)
i_87052c: BCH. DAl & Ct [bax. 100Hz)
i_87053c: 16 CH. D/l & Cnit [Ma=. 100Hz) Library————
i_87054: lzolated 8 CH. DI & B CH. DO

d

Mate

RERERRE-E
o)

i 97054c: 16 CH. [/0 & Crit [Max. 100Hz r
[ E7OES BCH DIG B CH DO ' Boards
i_87055c 88 CH. 1/0 & Cnt [Max. 100Hz] * Equipments

i 87058 BEH. D/ & Crt [Max. 100Hz)
i_87063: |solated 4 CH. DI & 4 CH. DO hd

Then double click the channel number on the right hand side to connect “OUT 101" and “OUT 102" .
(If find no “OUT 101" and “OUT 102", it means their attribution were not declared as “Output” .
Please refer to section 1.1.2 of this paper to declare their attribution as “Output” )

=
File Edit Tool: Option: Help
SRR =

[o] ﬂ mm| ref = 870558
mm i G7055 ER

[-] == DI8 n& rll\

A= Do8 ne =1 A
N x
Channel; | | Cloze |
....................................................

Free: {

== TE0T A0
[ ]

Conngct

Free

Mext

L

Prewvious
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Then click “Save” and exit it.

JRI=IF
File Edit Tool: Option: Help {
BePBR2O| L FR S
) 2| ) ref = 870558
mm i 87055 @ OUT_ 101
[-] = DIB n 2 OUT 102
A = D08 e ER -
[4 ]l
[5 ]
[6 ]
[7 ]
(6] ~| (&

1.1.6: Compiling The ISaGRAF Project

Select the following Compiler options. Must check the “ISA86M: TIC code for Intel” and the “Use
embedded SFC engine” and the first Optimizer “Run two optimizer passes” .

-=_ 13aGRAF - EL_01 - Programs -0l x|

File | Make Project Tools Debuwg Options Help

Make application e M RDE|

Begir Venfy
Touch

A pplication mm time Ophong

Compiler ophions

Eesoues

Compiler optionz

Beqg

T argets:

» SIMULATE: “Workbench Sirmulatar - Select
[SABEM: TIC code far Motarala

E o [SABEM: TIC code for ntel _

CC3EM: C source code [V3.04

Unzelect

v LUse embedded SFC engine

Jpload...

— Optirnizer:

¥ Bun bwo optimizer pazzes

r%luate constant expressions Ciefault
[~ Suppress unuzed labels —

[ Optimize wariable copying

[~ Optimize expressions

[ Suppress unused code

[ Dptimize arithmetic operations

[~ Optimize boolean operations

[ Build binamy decision diagrams [BDD]

LR

Cancel
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Then run “Make application” to compile the project.

- _I5aGRAF - EL._01 - Frograms - |EI|£|

File | Make FProject Tools Debwg Option: Help
Make application I& ia | 0m &4 | a, h=N |

Begir  Venfy

— e [SaGRAF - EL_01 - Code Generato

&

o ® Ele Options Edit Hebp

QP
_ VYerifying variables declarations

Veritying LD1 x

Mo error detected
Begin: ST1 (= Mo emor detected.

= Verifying 5T1
Mo error detected

Eesmm

Do you want ko exit the Code Generatar now 7

Continue |

Hesetting temporar

Building configuration data
Linking object files
Helocating object files

Post-compiling code
Mo error detected
Mo error detected

If no error detected, congratulations !

1.1.7: Download the ISaGRAF Project to the PAC

Click “Link Setup”.

-=_I18aGRAF - EL_01 - Programs -0 x|

File Make Project Tool: Debug Option: Help

B HLS2H DED =X mE 2En
Bleqin: fredy LD

Begin: =T1 [(Structured Text)
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To download project via Ethernet cable, please select “ETHERNET” and enter the IP address of the
PAC and must set Port number as 502.

PC-PLC link parameters x|
Target Slave Mumber: |'I | ok |

Communication part: | ETHERMET - Cancel |

Control

Time out [geconds]:
Feties:
ETHERNET link parameters x|

Intermet address: |1 921681181 | | oK

Part number: |5|:IE |

Cancel |

The Workbench uses the WINSOCK.DLL
ibrary for TCP-P communications. Ensure
that thiz file iz carectly installed on the hard
dizk.

Then click “Debug” to connect to the PAC. If it is connected, click “Stop Application” first and then
click “Download” to download the “TIC code for Intel” to the controller.

-=_I8aGRAF - EL._01 - Programs 10| %
File Make Poject Tool: Debug Option: Help
B HSE DBEMD| =X mb AE 5|
Begin: [y LD
8l ©@ ISaGERAF - EL_01 - Debugger - IEllj
File Control Tools Options  Help
@ri= > M| Q| AP
BU}! allowed=0

current=2 maximum=5 overflow=0

File Contol Tu:u:u]s Cption:  He
= r | &
Mo apn‘ir‘aiinn

12:17:Cbwnioad [ lication sto

.-’-‘-.pplln::atlan s_l,lmtn:nls

Download q LCancel
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1.2: Build eLogger HMI Project

If there are problems when running the eLogger RunTime, refer to section 1.3 of this paper to fix it.

The “eLogger” includes “Developer” and “RunTime” . The eLogger Developer is the development
toolkits installed in PC for building HMI pictures and items. The eLogger RunTime is the driver
installed in the PAC (WP-8xx7 or VP-2xW7 or XP-8xx7-CE6). User need to upload his HMI pictures
created by the eLogger Developer from PC to the PAC. Then the eLogger RunTime will execute it and
display HMI pictures on the VGA Monitor of the controller.

1.2.1: Install the eLogger Developer in PC and the eLogger RunTime in Controller

Please visit ftp://ftp.icpdas.com/pub/cd/winpac-8xx7/napdos/elogger/elogger_developer/ to
download the latest eLogger Developer .Then install it in PC.

Then visit ftp://ftp.icpdas.com/pub/cd/winpac-8xx7/napdos/elogger/elogger runtime/ to
download the eLogger RunTime.

It is better to show the “Taskbar” in the PAC 's VGA monitor at design time. Please enable it as below.

Connect one VGA Monitor to the VGA port of the controller. And connect one USB mouse to the
USB port of the controller. Then set the “Taskbar” as “Always on top”. DO NOT check the “Auto
hide” . Then run WinPAC utility (or ViewPAC Utility) to save the setting.

Taskbar, and|Start Menu
General | Advanced

Alweays on top
[ ] auto hide

Show Clock

@ Prograrms r
5% Favorites 4

) Documents  *

B Settings [ Contral Panel
(}, MNetwork and Dial-up Connections

B Taskbar and Start Menu...

WinPAC Utility, [2.0.1.3]

=8 Help Configuration

Save and Reboot
Feboot without Save
Restore Default Settings
Exit
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How to install eLogger RunTime:

Please click “My Device” on the controller's VGA. Then get into the “ \System_Disk\” path to create a
new folder “eLogger” .

E : \System_Disk!

My Device

Create new folder "eLogger”

e Edit View Go |
2]
Internet M B~
- | Software
Keyboard

Delete 4

Renarne
Properties LargekB 3
-~ : Hide Input Panel
| File Edit View Go | —|=£,F”=31 m|@|%
- -
e 2 Xd) E- AN
—vame \System_DiskleLoggert
@ELDQQEI’ ___,.-l-"'"- Y — gg
T ERtea_evice_driver
2 ICPDAS

To copy all files of the eLogger RunTime to the “\System_Disk\eLogger\” path of the controller, it is
better to use the ftp tools in PC . First make sure FTP is enabled in the controller and its path is set as
“\” . Then click “Setting”, then run File > Save and Reboot to save the FTP setting.

WinPAC Utility [2.0.1.3]
" File Help Configuration

[ System Setting lEﬂﬂernet Setting | FTP Setting | Systern Information ]ﬂuh:u E:

. ArCcess | Login ] N

FTF (8) Enable () Disable
allow anonymous | (8) Enable () Disable

allow Anomy mous (8) Enable () Disable
Upload

Change FTP default download directory YTemp to:

1 L ]

WinPAC Utility, [2.0.1.3]

N Help Configuration

Save and Reboot
Reboot without Save
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Entering the IP address of the connected controller on the Internet Explorer running in the PC, for

example, ftp://192.168.1.181

Then get into the “\System Disk\eLogger\” path, copy all files of the eLogger RunTime from PC to the
controller's “\System_Disk\eLogger\” path.

BEE HEE WRE EeRELW ITAO HE

OJ:—E v \_,-J K l?; fﬁ;ggg | B ||'—5' & x n|v

B D) 8D tp192 168.1 181/

=~ = = = I~
Control T indowes TWeh_Datal Treh Temp Sastern_Disk  Program
Panel Ink

Getinto the \System_DiskleLoggerl

Then click “My Device” on the VGA of the controller, get into the “\System Disk\eLogger\” path,
then run “eLogger.exe” . Check “Auto Run” and exit it .

\System_diskleLoggerl

My Device
-~ : | File Edit View Go |
: s B X3 3~
Internet -
S | Marme | Size | Tyt
|7 Language File
|2 Project File
CDIDrBut:Dn.dII 20.5KB  Apr

Oger.exe \2 143KB  Apg
gaet b 131KB PDE

(_)Execute Project %.HPE'EHFJE 3 |4

WinP&C SOk ¥1.2,3.5

~ Open Project

4 Receive Project

Project :
Systern_Diskielogger\ProjectiDemo. wez
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Run the WinPAC Utility (or ViewPAC Ultility) to set the second “Auto Execution” as
“\System_Disk\eLogger\eLogger.exe” (Note: the first execution of the WP-8xx7 and VP-2xW7
should be their ISaGRAF driver.). Then run File > “Save and Reboot” to save the settings.

WiInPAC Utility [2.0.1.3]
File Help Configuration

[SH;stem Setting lEﬂ’nernet Setting ]FTF' Setting lSystem Infor mation | AutD Execution | pMulti-serial pot
1
Program 1. |Eystem_DiskHisagraﬁisawinF‘.&C.exe N | ’ Browse ]
Program 2. \\System_Disk\eloggereLogger. exe ’ Browse
o
Program 3: | | ’ Browse ]
Program 4: | | ’ [ —— ]
Program 5: | | ’ Browse ]
At most 10
P 6:
programs can be rogram | | ’ Erore ]
EIJE':iF::‘Zd o Program 7: | | ’ Brawse ]
EXECL
automatically at - Program &: | | ’ Browse ]
Sl:fl-."-‘-_ = P T R, o — —
WinPAC Utility [2.0.1.3] | | ’ S ]
=8 Help Configuration ’ . ]
FowsE
Save and Reboot I Setting & ]
Reboot Without Sakg _— &
Restore Default Settirks 3

If problem happens while installing the eLogger RunTime, please refer to section 1.3 of this paper to
fix it.
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1.2.2: Building An eLogger Project

User may open an existing example project for reference. Copy “el._01.wez” ~ “eL_06.wez”
(downloaeded from Web 's FAQ-115) to the PC's C:\ICPDAS\eLogger\eLogger Developer\Project\
directory first. Then run eLogger Developer > Project > Open to open them.

Project | Edit 20

Upload Frojec BH0: [ Poject =l Qo ® =
B MNew HEL_DE.WEZ
'|lj Open @eL_ﬂ#.wez
Save as S oAt [ G)el_03wez
LEIFIQUE‘IQE HEL_DE.WEZ
izl _01.vez Y
Exit
B AD Tag it Q0 IeL_EIl.wez j BREE I
e SRR T IPrn:ujeu:t File (* wez) ;I HuiH

To create a new project - “eL._01”, please run Project > New . (DO NOT name it as “Demo” )
! eLogger Develop ¥1.0.2.0 2009/11/%6 CAMCPFDASeLoggerielogger DeveloperiProject

Project | Edit  View Layout Size  About

Upload Project  Ctrl+U -~ _

13 New o Cri+N_ ] Q ; -

5 Open N\ Ctrl+0

L b
() |6iject S e e s

{EEL el 02 wes
el 02 weg

[ e

DO NOT name it as "Demo”
”

&N feL_n1 | BRSO
T ATy IPrt:uject File (*wez) | Hrif

DO NOT check the “Local Database” if your controller will run eLogger HMI with ISaGRAF
Softlogic. Recommend to set the “Sampling Time” as 1 second.

S 5 ctern
Eli Driver(Newjl\ sampling Time(sec) | 1
B St

EI-= Tag Mapping [ Local Database
] AlTag Recard Time(hour) | 1
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And DO NOT add any Device and Modify them in the eLogger 's Driver menu, leave them empty.
(eLogger HMI working with ISaGRAF SoftLogic cannot support any eLogger Device, or it will fail.)

!eLugger Develop ¥1.0.2.0 2009/11/6 CAICFDASeLoggertelogger DeveloperiFrojec
Project Edit View LayoutSize  About

15 K | Noo
g

...... ﬁ S'_.I.'Stem
=8 i Drwer (= Tirme Out(ms) | 200
...... - |||
COM Port -
=} .E Tag Mapm\ DO NOT add S B El
------ .H Al Tag device and Baudrate [175500 -
- B A0 Tag [Mofidy them. I [
..... B DI Tag \5@31‘3‘”“ |Disable =]
...... £ DO Tag
=t ﬁ F'age Mew) +Device | Modifyr
...... ' Pagel:l

1.2.3: Declare eLogger Tags
To make eLogger HMI communicate to the ISSGRAF SoftLogic well, only “AO Tag” and “DO Tag”
can be used (eLogger 's Al Tag and DI Tag cannot communicate with ISSGRAF 's variables) .

Click “AO Tag” to declare several AO Tags.

!eLugger Develop ¥1.0.2.0 2009/11/6 CMCPDASwLoggeriel.ogzer DeveloperiPg
Froject Edit “iew Layoutsize  About

1 45 Ko _ M ¢
X 1

- ﬁ System Memory Addres | Name | Zervice Type
=B i Diriver (P enw)

...... B8y Slot

= .= Tag Mapping

NewTag o |  Delse Tag | Seding |
Tag Name \ Diescription Memorr Ac
| | | O
| Tag Name | Dieseriptian | Memaoryr Addn
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Enter 4 in the following pop-up window.

Add Tag |
How manyr fags to add?
|4
ok | Concel |
Y

Then click the first tag to key-in the Tag Name as “Long 17, Memory Add as 1, Data Type as “32-bit

Signed Long” , Gain as 1 and Offset as 0 .

(ISaGRAF 32-bit Integer and Real must occupy two network address numbers. Here the address of
“Long_1”1s 1, so the address number “2” must not assign for other tags. Please refer to the section 4.2

of the ISaGRAF User's Manual)

Mew Tag | Lelete Tag | Braling |
Tag Name Dezcription Memory Ldd Data Type G Offsmt
|32-bit long [ [ L] [s-bitsiensd Lone =l | [ o]
Tag Name Description | Memory Addres: | Data Type (rain Offzet
Long 1 332-bit long 1 33-bit Bigned Long 1 1]
\ A1 A1 16-bit Bigned Inte. .. 1 1]
A0 A0 16-bat Signed Inte. .. 1 n
ACQZ ACQZ 16-hit Bigned Inte. . 1 1]
Then declare the 2™, 3rd and 4th AO Tag as below table.
Tag Name | Memory Add Data Type Gain Offset
Word 3 3 16-bit Signed Integer 1 0
Word 4 4 16-bit Signed Integer 1 0
Float 5 5 32-bit Flaot 1 0
Then we got the following picture.
Newlsg | Debe Teg | Soeling |
Tag Mame Descr:phion M Add Data Type Crain Offzet
Float_5 [R8! Real) | - IEE-bit Float =l 1 0
Tag Mame Dreacription Memory &ddres: Diata Tpe Cradr. Offzet
Long_1 32-bit long 1 32-bit Bigned Long 1 1]
TWopd_3 ¥ (Beconds) 3 16-hit Higned Inte... 1 1]
Word_4 4 16-bit Bigned. Inte... 1 1]
B e F8! (Real) 5 32-bit Flaat 1 0
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Click “DO Tag” to declare two DO Tags( DO_101 and DO 102 with address as 101 and 102
resoectively). The eLogger tag name can be a different name from the ISaGRAF variable (Because
they are shared data by using the Memory Addr, called “Network Address” in ISaGRAF) .

Tag Name | Memory Add Data Type Gain Offset
DO_101 101 - - -
DO _102 102 - - -
E System Memory Address | Name | Service Type | Li
EIE Driver(Mew)
1By Slot

|:—:|.= Tay Mapping

f% Add Tag x| =

Howe mamnyr tags to add?

Mew Tag \l [}

er] e

IF]J:uat_E |§E |2

OK » Cancel | J

v Y
NewTog |  Delet Tag [ [ soine |
—Tag MName Description Memory &dd Data, Tar
|DO_1EIE | |32-bit Fl:
Tag Mame Diescription Memory Address
Do 10 101
» Do 102 102

1.2.4: Creating An eLogger Page

The eLogger RunTime will show the “Page0” when started (user can rename it). This sample project
uses two pages, the Page0 and Pagel.

To declare the second page, click “Page(New)” on the left, then click “New” on the right. You may
name it to a different name (or name it as Pagel).
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! elogger Develop ¥1.0.2.0 2009/11/6 CAICPDAS\eLoggerlelogger DeveloperiProjectie

Froect Edit “iew Layout>ize About

N D12
g

oo ﬁ System
=& Driver(New) Pagel | 3 New N2
i) l@. Slot j
[_]ﬂ Tag Mapping Paged Renaine
-~ Al Tag Remove
..... _= A Tag
..... _= Ol Tag Tmport
- _= D0 Tagy
|'__'|... . Export
P ' Fagel 1

Click the “Pagel” on the left to edit the second page. First, Select the VGA layout size to fit the PAC
(The max. resolution is WP-8x47: 800 x 600, WP-8x37: 1024 x 768, VP-25W7: 640 x 480, VP-23W7:
320 x 240; The VP-23W7: doesn't build-in a Touch screen, however the VP-25W7 is built-in with a
Touch screen). Then the “Property” window will pop-up, or please click View > Component
Properties to open it.

! eLogger Develop ¥1.0.2.0 2009/11/6 CACPDASwLoggerieLogger Developer\Projectiel 01 wez

Froject Edit  View | Layout Size | About
320x240 r

2345 Ko j fhﬁ_ﬁl 640x480 L LR A
800x600 o |

— ﬁ oystem
Eli Driver(Mew) 1024768 \

- E. Slot Property =]
=58 Tag Mapping Cutput Limit{tas) 0.000
""" & AlTay Outpt Limit(Min) 0.000
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1.2.4.1: Add Component - Label

Add a component “Label” in the second page (named Pagel) for this example.

ﬂ eLogger Develop ¥1.0.2.0 2009/11/6 CAICPDAS\eLoggerelogger DeveloperiProjectiel: 01 wez

Froject Edit  View Layout Size  About

Ty A L@

EE DitiverMesw)
-1y Slot

-4 Tag Mapping

=-E# Page(MNew)
----- & Pagel

-----

Drag the component to the proper position. Then set up the display text, font size and color in the

Property window.

o - o
p imi 0.000
) PagE1 (%25) 5 Cutput Limithdas)
& . Orutput Limit i) 0.000
E DataPointer
Address Mot support

AddressType Mot support

B DisplayFormat

DisplayText Page1 (FE2H)
FontSize 14
Fore_Colar I red

The Property window also can be opened by click View > Component Properties.

ﬂ eLogger Develop ¥1.0.2.0 2009/11/6 CAICPDAS\eL oggmerie

Froject  Edit
7145 Kg j

View | Layout Size  About

Component Properties

= | .

To delete an existed component, please select it then click Edit > Delete .

! elogger Develop ¥1.0.2.0 2009/11/6 C:A(

Froject

T AL K
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1.2.4.2: Add Component - SwitchPage

To add a “SwitchPage”, please click “Button” in the first page “Pagel”.
009/11/6 CAICPDAS\eLoggerelogger Developer\Projectiel. 01 we=

Layout Size  About

=g

ON
[

f

'I_I

Page1 (552H)

012 A

Pagel

Set Button Type as “SwitchPage”, Switch Page To as “Page0” . Then, setup the “DisplayText”,

“FontSize” and “Fore Color” you want.

Pagel (52H)

i}

(]

D Goto Page 0

T

ik

Bufton Type ISwitchPage ;

L

4

Switch Page To ||Pageﬂ I

sl

B DataPointer
Address Mot support
ArdressTwhe Lot snnpor

Bl DisplayFormat
Back_Colar [ ] 224,224,224
DisplayText Goto Page 0
FontSize 14
Fore_Colar I Blue

Then, click “Page0” on the left, add a “Label” and a “SwitchPage” by the similar way.

A Q=

Elg Ditivve (M esw)
-1y Slot

=-f] Tag Mapping
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012 A Pagel
? = \ E
Page 0 o Goto #2H ¢
o n u
F
Button Type  |SwitchPage -
Switch Page To | [Pagel |
B DataPointer
Address Mot support
AddressType Mot support
B DisplayFormat
Back_Caolar [] 224,224,224
DisplayText Goto FE2H
FontSize 14
Fare_Calar B 255,0,0
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1.2.4.3: Add Component - LED

In the page0, click “LED” to add a LED component.
ogzerveloggzer DeveloperiProjectiel. 01 wez

-!; Q& 012 A Pagel

Page 0 E@b Goto 2H ‘

Lt

This “LED” is to control the [ISaGRAF variable OUT 101 (the relative DO Tag in eLogger is

DO _101). Please set Tag Type as “DO Tag” , Tag Name as “DO_101", ConfirmWindow as “True”
(will output after confirmation), MouseControl as “True” (True: allow Tag outputs its value; False:
read only, not allowed to output). Then setup the Text and color you want.

Pagt  TagTye | DO Taz

Tag Description
(e I o Catput Linit(bdac) 0000

: D Crutput Limit(Min) 0.000
B DataPointer

(poocoocco fu ey Address 101
AddressType CoilStatus

E DisplayFormat
Confirmbyindow True|

FontSize 12

LedStyle Ellipse
[MouseContral  Tru

DfColor I 0:?2?:5""

[OfDisplayText  OFF|
OffTextCalar [ | White
QnColor
OnDisplayText
OnTextCalar Black
YalueTest False

Please click View > Component Properties to open this Property window if it is closed.

Froject Edit | View | Layout Size  About
Component Properties
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1.2.4.4: Add Component - Switch

In the Page0, click “Switch” to add a Switch component.
DASeLogzerieLogger DeveloperiProjectiel. 01 we=

About

a L og 012 A Pagel

Switch

Page O Goto 2H ‘

Set Tag Type as “DO Tag” , Tag Name as “DO_102” , ConfirmWindow as “True” (will output after
confirmation), MouseControl as “True” (True: allow Tag outputs its value; False: read only, not
allowed to output). Then setup the Text and color you want.

Page 0 Goto 2H ‘
D ......... D ......... D
0 O
| —
D ......... D ........ D
Tag Dezcription
Cufpat Limit(hda) 0.000
Chatpat Livndt(ddin) 0.000
B DataPointer
Address 102
AddressType CoilStatus
E_DisplavEo

MaouseCantral True

OffCalor Maroon
OffDisplayText

OnColor I Red
OnDisplayText

YalueTest False

Then add two Labels as the descriptions for the LED and Switch (refer to section:1.2.4.1).

Page 0 Goto E2H ‘

2 DO 102 &
DO_101 2 DO 102 @
@ —
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1.2.4.5: Add Component - Seven Segment

Click “Seven Segment” to add a Seven Segment numerical component.

H eLogger Develop ¥1.0.2.0 2009/1156 CAMCFEFDAS

Froject Edit  View LayoutSize A

- Q System
E‘E Eriver(New} | seven B gent

Set Tag type as “AO_Tag” , Tag Name as “Long_1" and MouseControl as “True” (True: allow Tag
outputs its value; False: read only, not allowed to output). In this example, the data type of long_1 is
32-bit long, no decimal places needed, so set “Decimal” as 0, DigitalNumber as 10 (can be 1 ~ 24). If
user’s application has output range limitation for local operators, please do the extra setting in the
“Output Limit (Max)” and “Output Limit (Min)” .

|
F’age 0 Tag Tvpe L0 Tag
Tag Name |L|:|ng_1 |
Do 107 DD_1 0z Tag Description KR long
= Cratput Limdt(Mac) 2147483647
@ Output Limit(Min) 147455645
— B DataPointer
Address 1
AddressType HoldingRegister
DataType A2-hit Signed Long
Gain 1
Offzet 1]
Range -214T483648.000~214
B DisplayFormat
Decimal
Digitalturmber
Fore Color Red
MouseCaontrol ;I
Testalue 0

Then add a Label as its description.

8
g
0

Long 1

_T
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To delete an un-need component, please select it, then click Edit > Delete .

HeLugger Develop ¥1.0.2.0 2009/11/6 A
Froject | Edit | View Layout Size

' S— Delete h >

By the similar way, add one more “Seven Segment” component with Tag Type as “AO Tag” , Tag
Name as “Word 3" (In this example, this value is to read the “second” value from the WP-8xx7 PAC’s
time value), “MouseControl” as “False” (True: allow Tag outputs its value; False: read only, not
allowed to output) , Decimal as 0 and DigitalNumber as 3.

Tag Description  [TF (Seconds)

Cngtput Livgdt (e el
Coatput Limdt(din) -34768
B DataPointer
Address 3
AddressType HoldingRegister
DrataType 16-hit Signed Integer
Eain 1
Offzet 1]
Fange -32TEB.000~3276ET 000
= Di
Decimal 0
DigitalMumber 3
Fore Calar [ Lime
| fouseControl False-l
Testalue 0

Then we got the following picture — Page0.

Page 0 Goto E£2H
DO_101 DO _102
@
Long 1 F
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Then by the similar way, add a “Seven Segment” component with Tag Type as “AO Tag” , Tag Name
as “Float_5” , MouseControl as “True” (True: allow Tag outputs its value; False: read only, not
allowed to output), DigitalNumber as 7 and “Decimal” as 2 (display 2 decimal places). The range that

operator can input is -1000 ~ +1000, so please set its “Output Limit(Max)”” as 1000 and “Output
Limit(Min)” as -1000 .

A
Tag Description
Chptpt Leimiatbda)
Crntpat Lamdt(bd i) -1000
B DataPointer
Address a
AddressType HoldingRenister
DataType 32-hit Float
Gain 1
Offset N
Fange --
B DisplayFormat
Decimal 2
DigitalMumber 7
Fore Color [ | Yellow
|ru1|:|useC|:|ntr|:|I True |
Testvalue 0
Then add a Label as its description. Then we got the following picture.
Page O Goto E2H ‘
Do 101 Do 102
Q —
Long 1 o Float_ 5

+
ca
+
3
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1.2.4.6: Add Component - Angular Gauge

To add an “Angular Gauge”, please click Angular Gauge as below.

q eLoggzer Develop ¥1.0.2.0 2009/11/6 CAI

Froject  Edit  View  Layout Size

------ ﬁ System

=& Driver(Mew)

First, set Tag Type as “AO Tag” , Tag Name as “Word_4”, MouseControl as False, “ScaleMin” as 0,
“ScaleMax” as 50 (In this example, ISaGRAF output range is 0 ~ 50). Next set “GaugeAngleMin” as
150 degrees (It means the minimum value is in the location of 150 degrees, anti-clockwise direction),
“GaugeAngleSpan” as 120 degrees (It means the entire header open up can be 120 degrees.),
“ColorSectionGreenStart” as 0 , “ColorSectionGreenStop” as 20 , “ColorYellowSectionStart” as 20
and “ColorYellowSectionStop” as 40.

@ —
Tag Description
Crgtpt Linit(bdas) 32767
Long_1 sl 32768
L -HEpe =
Address 4
AddressType HoldingReg
DataType 16-hit Signe
Gain 1
= 0 | Offset I
200 300 Range -32762.000-
100 g T, 40 Fl DisplayFarnat
: ColorSectionGreensStart 0
w OO A ColorSectionGreenStop 20
ColorSectionellowStart 20
\ ColorSectionyellowStop 40
GaugeAnglemin 150
C C C GaugeAngleSpan 120
MouseControl False
ScaleMax 50 b
Scalebin 0
TEsTvalle 1] -
- - - - 1

Add a Label as its description. At last, we got the following picture.
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Page 0:

Page 0 Goto 5528
DO 101 DO_102
@
Long 1 F Float_ 5
S $CFEE C oo O
Word 4
200 00
a .

10 T, 400
oo / \50.0

Page 1:
Page1 (382E)

Goto Page 0

Save Project.

M cLogger Develop ¥1.0.2.0 2009/11/6
Froect | BEdit “iew Layout

Upload Project  Ctrl+U

1 Mew Crl+M
= Open _trl+0
[| Save as Ctri+A |

ISaGRAF FAQ-115 Version 1.01 ICP DAS

37



1.2.4.7: Recommend To Backup The Finished Project File For Safety

For safety reason, recommend to backup the project file.The finished eLogger Project file resides in the
C:\ICPDAS\eLogger\eLogger Developer\Project\ directory.

=
BEE® fﬁﬁ@ W EHSEW TAED HOA® awn
Jome e |5 (3 X Y|
D) |L:",~ CAICPDASeLogzerieLogger_DeveloperProject | B =
e x || &8 D
SR = ] el _05 wez 63KE WEZ %
A J ] 6L _04 wez 62KE WEZ 3%
4 35 EEE (A SKE WEZ#&E
AR () 61 KB WEZ #8%
1 3 Chun el _(] wez 13KE WEZ 8%
1 &) evgwin Ij%ﬁt " _01 ez 13KB WEZ#%
7 ) DAQPro
) defBad 35bee 3:24006938865a7 _
Il I TP N N 5, I N B .I. _}I—I ‘ I I ﬂ
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1.2.5: Download the eLogger project to PAC

This example uses a WP-8447 + slot 1: I-87055W(leftmost I/O slot number is 0) as the hardware and
uses the ISaGRAF SoftLogic + eLogger HMI as the software. First, please download the ISSGRAF
project into WP-8447. (Please refer to the section 1.1.7 or 1.1 of this paper.)

The PAC must pre-install the eLogger RunTime and setup the relative configuration. (Please refer to
the section 1.2.1 of this paper.) Then turn on the power, ISaGRAF and eLogger RunTime will start up
automatically.

Before downloading the eLogger project, must close the eLogger project currently running in the PAC.
Please use mouse right key click on the “eLogger” Taskbar in the screen bottom to close it. (If using
Touch Monitor, such as VP-25W7, there is no Mouse right key, please turn off the WP-8xx7/VP-
2xW7 PAC, switch its Rotary Switch to 1, then reboot the PAC. The eLogger will not do the Auto-
Execution and ready for the next step. After download the eLogger project to the PAC, remember
switch the Rotary Switch to 0, then reboot PAC).

D.D{ / \SD.D ‘ Goto Page 1 ‘

=R

Double click “My Device”, then get into ““ \System_ Disk\eLogger\” path to delete the file
“ICPDAS eLogger.xml” .

ilJ eLogger ¥1.0.0.0 2009{11f03

\System_DiskleLoggerl

My Device  rs_wphmi

-~ File Edit View Go
T ¢ > P X@ E-

gl e [
' Language '
' Project
ColorButton.di 20.5KB,
W/ eLogger.exe 14EH<EI=
] eLogger . pdb - —
FiIteredF‘erertyGrid.z Edit View Go |

FCPDAS, elagger. <mil I el X v B~

iIII.iI"Ii [ Meww Folder :[
(V0 g =T = A
pac_ig017HwW.dl m L
pac_iB017HWNet, i | REname i

pac_|E:D24W.dII % 1er . xrml
Send To
- Mmentation.C...
Close B
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After that, run the eLogger.exe again (mouse double click). The eLogger will show “Project not exist”
(Because the file ICPDAS_ eLogger.xml has been deleted.)

| File Edit View Go |
«» |3 X @=-

| Marne |
' Languagz

' Project

ColorButton.dl

 lol ogger exe \ )
=] eLogger pob . Ao Load /
9] FiteredRropertyGrid.dl e 00 80T

[T DM A al Anaar wol lI"-"II:I- -D-E-D 2':":'9,'{1 1,"1‘16

Project not exist,

RunTime Version
is listed here

Click “OK” in the top. Don’t change the “Auto Run”, that had checked in the section 1.2.1.
Please click “Receive Project” to wait the PC / eLogger Developer sending over the eLogger project.

ellogger, ¥1.0.2.0 2009f11f16

U Execute Prnject

q WinPAaCZ SOk Y1235
Open Project

¥ Receive Project
.,

FProject : N
Systern_DiskeloggerProjechDemo.wez

On the PC side, to send the eLogger project to PAC, please click Project > “Upload Project” of
eLogger Developer, then input the PAC 's IP address and click “OK”.

ﬂeLugger Develop ¥1.0.2.0 2009/11/6 CAMCPDASwLogzerielogzger DeveloperiF

Froect | Edit View LayoutSize  About

| Upload Project  Ctri+U | x|
A Mew Ctri+M
= Open Ctrl+0) Pleaze input the IP address of the WinPAC!
Save as Crl+ A, [192.168.1.181
Language 3 T Concal |
Exit Crl+ N y
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If the operation is successful, the eLogger Run Time will show the eLogger Project name (eL_01.wez
in this example). Please click “Execute Project” to run the new eLogger project, or reset the PAC that
also can run the new eLogger project (If the eLogger does not auto-run after resetting PAC, it means
the eLogger does not set to Auto-Execution and Auto-Run. Please refer to the last 2 steps of the section
1.2.1.).

el.ogger. ¥1.0.2.0 2009/11/16

AUtD Run
| |

WinPAc SDK ¥1.2.3.5

(_)Execute Project
.

Ny

Open Project

4 Receive Project

Project
ystern_DiskieloggerProjectel 01 wez

After test and confirm the Project, when the PAC is ready for long time running, user can hide the
Taskbar, so that the eLogger project can be displayed on full screen. Then run WinPAC Utility (or
ViewPAC Utility), click File > “Save and Reboot” to save the setting to the Registry.

la Prograrns r
Taskbar. and Start Menu m

D Docurnents  *

P Settings [ Contral Panel
@ Help t} Metworl: and Dial-up Connections

= Run,.. B Taskbar and Start Merw,..

*-ﬂ? Favorites k
General | advanced

[ ] Always on top

Auto hide

wlnpAc Utllltf [2']1.3] .................................

#=8 Help Configuration

Save and Reboot
Reboot Without Save
Restore Default Settings
Exit

It is suggested to display the Taskbar when it is in the design and test time.
When using the full screen display for the eLogger HMI (hide the Taskbar), please refer to the section
1.3 if user want to modify the eLogger project again.
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1.2.6: Testing The eLogger HMI

When WP-8xx7 / VP-2xW7 (or the XP-8xx7-CE6 available in the future) has received and Auto-Run
the eLogger project, the “eL._01” (in this example) will show on the VGA of PAC as below. You can
click “Float 5” and input a value to test it, and use ISaGRAF to connect the PAC to see if the value

correct or not.

Fr# (Real);-1000~1000 E]

Goto 525

1| 2| 3 || - | oK ‘
4 > 6 + |Cance|‘
7 8 9 |—
0 << || C
ong_1

10.0

Word 4

200 300

'.'--'.'||'I
L
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1.3: eLogger Run Time Trouble Shooting

If there are troubles when installing the eLogger Run Time, or the eLogger Run Time cannot be turned
off when using the eLogger full screen, please power off the PAC, switch the Rotary Switch to 1, then
reboot the PAC.

After rebooting, ISaGRAF and eLogger will not auto-Run.

Next, get into “\System Disk\eLogger\” path to delete the file “ICPDAS eLogger.xml” (or rename
it). Then when the eLogger auto-run again, it will not find the project, so that the user can download
the new Project to it. (If want to re-install the eLogger Run Time, first, delete all the files in the folder
“\System_Disk\eLogger \”, then follow the steps in section 1.2.1 to re-install it.)

My Device  rs_w

: File Edit View Go
Ve |

\System_DiskleLoggen

2| @ ¥ X E-~
Internet | Marme | G-
Explarer !
' Language '
' Project
ColorButtan.dl 20.5KE,
W/ eLogger.exe 14BKEI=

elLogger.pdb 151kE,
FilteredPropertyGrid. di 8.50KE,
ICPDAS_elogger.=mil
i ini

Iocomp. Instrurmentati

pac_is017Hvy.dl 12KE,
pac_ig017HwMet.dl FOKE,
pac_ig024vy.dl 1 1KE

After deleting \System_ Disk\eLogger\ICPDAS eLogger.xml, please turn off the PAC, switch the
Rotary Switch to 0, reboot the PAC. The eLogger project will not auto-run this time. (Because it
cannot find the eLogger project.)
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1.4: Other eLogger Advanced Functions

1.4.1: Setting Gain & Offset for scalling data

In many applications, it needs to display the engineering data values rather than the integer data values.
For instance, the [-8017HW module, when setting the “Range” as 8, its value measured in ISaGRAF is
(-32768 ~+32767). That is a signed 16-bit integer to represent (-10 ~+10) Volt. To display the -10
~ +10 value on the eLogger HMI, we must set the Gain and Offset.

NOTE: If the Gain is set to 1 and the Offset is set to 0, it means without data scalling.

Formula: Y = [Gain] * X + [Offset]

Convert (X0 ~ X1) to (Y0 ~ Y1), that

Gain= (Y1-Y0)/(X1-X0)
Offset= (X1 *Y0—-X0*Y1)/(X1-X0)

For example: convert ( -32768 ~ 32767 )to (-10 ~ 10), that
X0=-32768 , X1=32767 , YO=-10, Y1 =10
So the result will be

Gain = 0.0003051804 (Gain : even its value is very small, don’t ignore it.)
Offset = 0.0001525902 (Offset : if its value is too small, we usually ignore it and set it to 0.)

So if the “Al_7” Tag is to read the value from one Channel of the [-8017HW, the Gain and the Offset
can be set as below. (NOTE: Data_Type is a “16-bit Signed Integer”. )

W e | Tkt s T | Sosling |
Tag Name Descriptinn Memony dd Diats Tpe Cradn Oiffset
A7 [ ] 'lﬁ-hit Sigwed Integer | =] || 00003051804 | [0
Tag Mame Dezcription Memory Lddress Data Type (Cradi Offzat
AT 7 7 16-bit Signed Inte... 0000320518 0

The converted value displayed in the eLogger project is showing in the next page.
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In the Property window, please set “TestValue” to the maximum converted value while doing the test,
10 in this example.

Froperty =]
Tag Type A0 Tag hd
3 %EE" TagName | JAL7 |
Tag Description
Chatput Limathdac) 10,00
Catpunt Limdt(kd i) -10.0
B DataPointer
Address T
AddressType HoldingRegister
DataType 16-bit Signed Integer
Eain n.oo03nata
Float 5 Offset 0
A — Fange -10.000~10.000
] + : I-' -: '-: :-l =T DisplayFormat
S— Decimal 2
Digitalsumber 4
Fore_caolor 0, 255, 0
mMouseControl  False
Testfalue 10
TestValue
Input the walue to test the display.
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1.4.2: Declare Many eLogger Tags With Similar Names And Same Format

User may declare may eLogger Tags with similar names and same format as the following.
!eLugger Develop ¥1.0.2.0 2009/11/16 CAMCPFDAS‘eLoggerleLogzger Developeri\Frojectitestll wez

Froject Edit View Layoutzize  About

= | L@

: 012 A Pagel

- E System Memory &ddress | Wame | Bervice Tyme | Location
=@ Driver(Mew)
..y Slot
Elﬂ Tag Mapping
Add Tagz |
NewTog o |  Delsts Tag [ s
Tag Name \ Diescription How many tags to add?
| [i0
| Tae Warna | Tlasrwintinn
0K o Concel |
N\ y
Use “Shift” key and Mouse to select these Tags, then set them to have the same format.
NewTog |  Delst Tag [ sooling |
Tag Name Description Memonr £dd Data, Tpe
| [ 32-hit Float |
16-hit Bigned Integer
Tag Name Diescriptinn Mermaory &ddre 16-bit Tnsigned Integer
33-bit Bigned Long
400 400 nll) | 33-bit nsizned Long
& t Floa
A1 A01 (nudly ~
aAQZ A03 (D) 33-hit Float
LDz J.{k) (ol 32-bit Float
A4 &04 (null) 33-hat Float
A5 A05 (null) 33-hat Float
AR L0006 (D) 33-hit Float
a7 &07 (D) 33-hit Float
A03 L03 (D) 33-hit Float
AQQ A09 (D) 32-hit Float
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Then setting as similar Names and similar Descriptions.

Mew Tag | Delete Tag | Braling |
ey W12 Description Memory £dd Data Twpe
VAL | | -1 [32-bitFloat
Tag Name Diescription Memoryr Lddres: Diata Tpe
WAL O 400 (ol 32-bit Float
VAL 1 401 {ull) 32-bit Float
WAL 2 L2 {ull) 32-bit Float
WAL 3 403 (ull) 32-bit Float
WAL 4 404 (ool 32-bit Float
VAL 5 405 (ool 32-bit Float
VAL 6 406 (ool 32-bit Float
VAL 7 AC7 fovull) 32-bit Float
WAL 8 L8 {ull) 32-bit Float
WAL 9 408 {ull) 32-bit Float
Wew Tag | Delete Tag | sraling |
Tag Name ipticmn Memory Ldd Data Type
VAL |iRE£LL vale | | 32-bit Float
Tag Name Dlescription Mermonr &ddress Diata Tpe
WAL 0 REAL wale_0 umll) 32-bit Float
Val_l REAL vale_1 umll) 32-bit Float
WAL 2 REAL wale_2 umll) 32-bit Float
VAL 3 REAL wale_3 umll) 32-bit Float
VAL _4 REAL wale_4 umll) 32-bit Float
WAL 5 REAL wale_5 umll) 32-bit Float
VAL 6 REAL vale_6 umll) 32-bit Float
WAL 7 REAL wale_7 umll) 32-bit Float
WAL 8 REAL wale_8 umll) 32-bit Float
WAl 9 REAL wale 9 umll) 32-bit Float
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1.5: Some Useful eL.ogger + ISaGRAF Example Programs

The example programs listed in this section can be downloaded at the following web site.

www.icpdas.com > FAQ > Software > ISaGRAF > FAQ-115

User may open the eLogger example programs for studying. First copy “eL_01.wez” ~ “eL._06.wez” to
PC’s C:\ICPDAS\eLogger\eLogger Developer\Project\ directory, then run Project > Open to open
them.

! elogger Develop ¥1.0.2.0 2009/11/16
Project | Edit v 2l

Upload Frojec TN I_}Prt:uject j 3 T CF [
a Mew ﬂeL_ﬂE.wez
'|Lj Dpen JEL 04 ez
Save as \ # |JEL 03 wez
el
Language |5 eL_D1 wez
Exit
] AD Tag

e 1 IeL_EIZ.wez j ,| B o
T SEEEE (T IPrc:ject File (* wez) j Hrif

User may open the ISaGRAF programs for studying. First restore “el._01.pia” ~ “eL_06.pia” to PC/
ISaGRAF, then double click the project name to open it.

| BI5aGRAF - Project Management - 10| x|
File Edit Project | Tools Options Help

| ] Archive Projects i\ |

Libraries

creation
Lt 87005 |
[11]

- Archive - Prn]ects x|

Wwhorkbench Archive —

A.; 215win - Backup | -7 153aGRAF - Project Management
Dz aLdEFIQ Fil: Edit Project Tools Options H
charl_

____ |creation . Restore Sl | ] m | 12 & | i
:glt:é‘l:li i E Close el 01 eLogger + 15aGF
igkdpi_2 — \ 3 —I_ 5 elogger + [SaGF
igkdpi_3 el 03 eLogger + [SaGF
mb_tepl Help
{67005 el 04 pouple oo+ 1S
t_87005a el _05 Click 5. deta forr
tE_S_lTI_z —— ——
test] Reference rel U2
test 1 - W Compress Author
— Archive location Date of creation : 2009111119
O:ACHUMN_DMEr s FADNFART15~1Y Browse \ !

2N
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1.5.1: Using A Pulse ON Then OFF Button To Control Something

ISaGRAF project file :
eLogger project file :

el 02.pia
eL 02.wez

This example setup an eLogger “Switch” . The ISaGRAF program will send a message which contains
the PAC’s date and time from the WP-8xx7 ‘s COM1: RS-232 to PC when setting this “Switch” to
ON. User may run one Hyper-Terminal utility in PC to open a RS-232 port (9600,8,N,1) to receive this
message. Then the “Switch” state will reset to OFF automatically by the ISaGRAF program.

eLogger Developer:
. 0O Tag
& F'age[Newj\
P ' Pageﬂ New Tag | Delete Tag | praling |
AT Diescription Mermoroy £dd Data Ty
0 o
Tag Name Dezcription Memorr Lddres:

» Swritchl 1

¥,

el 02 section 1.5.1inFAC Tag Type

press "send it to send a mes: Tag Dessription

o = 2 Output Limit(ac) 0.ooo

6 Send_it & OutputLimit(Min) 0.000

|:: — D E DataPointer

- Address 1
AddressType CoilStatus
B DisplayFormat
Canfirmindow  True
FontSize 12
MouseCantrol True
OffColar 0, 127,0
OfDisplayText  Send_it
onCalor 1 o, 2550
OnDisplayText Send_it
YalueTest False
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[SaGRAF :

Variables:
Name Type Attribution | NetWork Description
Addr.
Switchl Boolean Internal 1 To access to eLogger ‘s Switch
TMP Boolean Internal 0
INIT Boolean Internal 0 Declare its initial value as TRUE
STRI1 Message Internal 0 Declare its max. Length as 64
Yearl Integer Internal 0 To get PAC ‘s year
Monthl Integer Internal 0 To get PAC ¢ s month
Dayl Integer Internal 0 To get PAC * s day in month
WeekDay1 Integer Internal 0 To get PAC * s weekday
Hourl Integer Internal 0 To get PAC * s hour
Minutel Integer Internal 0 To get PAC * s minute
Secondl Integer Internal 0 To get PAC * s second
Project :

-=_[SaGRAF - EL._02 - Frograms

File: Make Project Tool: Debug

B HRHX DEM ¥ Xie mH

Option:  Help

=10 %]

=LY

Begin:
[ LD1

Begin: ST1 (Structured Text)

ISaGRAF FAQ-115 Version 1.01
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Program - ST1:

(* Open COM1 as 9600,8,N,1 at 1st scan cycle

must declare "INIT" with an initail value at True *)

if INIT then

INIT :=False ; (* only do it once in the 1st scan cycle *)

TMP := COMOPEN(1,9600,8,0,1);

end_if ;

(* If eLogger set "Switch1" as True , send message to COM1 *)

if switchl then

(* Convert data and time to a string , like 'Feb/18/2010,13:25:45' *)

strl := time_str( year1l , monthl , dayl , weekdayl , hourl , minutel , secondl ) ;
strl :=str1 + MSG('$SODS0A") ; (* Add <CR><LF> at the end of string *)

(* send one message to COM1 *)
TMP := COMSTR_W(1,strl);

switchl := False ; (* reset it when finished *)

end_if ;

Program - LDI:

™ get PAC 's date and time *)

"

SYSDAT_R

En

Eno

WY_
hhd_

0o_

WY

—ye st
—mionth
e

e e ko &y

ISaGRAF FAQ-115 Version 1.01
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SYSTIM_R
eno

HH_

hofhd _

20

—hourl

—minutet

—secondi
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How to test ? :

Connect one RS-232 Cable from the WP-8xx7 ‘s COM1 to one RS-232 port of PC ( refer to Appendix
A.5 of the WP-8xx7 Getting Started Manual for COM1 ‘s pin assignment). Then power up the WP-
8xx7 and run the Hyper-Terminal utility in PC to open that RS-232 port as 9600, 8, N, 1.

WP-8xx7 - eLogger HMI :
You may click the “Send it” button and set as ON to send one message to PC .

el 02 section 1.5.1 in FACQ-115

press "Send_it" to send a message to COM1 (9600,8,1,1)

Send it \

PC — Hyper Terminal (9600, 8, N, 1) :
=5 COM1,9600,8N1 - BB FiaiE i [m] 1

BEE REE @R P #E HAH

Nov/20/2009,12:11:23,Fr1
Nov/20/2009,12:11:30,Fr1
Nov/20/2009,12:11:38,Fr1

=

-
4| | »

A

E#R000920 |EEh&EI [DG00SN-1  [JLROLL [CAFE [WOM [RE[FIET
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1.5.2: Read Or Save Process Parameters From/To A File. The File Contains Two
Rows, Each has Ten REAL Values.

ISaGRAF project file : el _03.pia
eLogger project file : el 03.wez

There is one another “el._04” project similar to this “eL._03”. However its data format is integer.
ISaGRAF project file : el 04.pia
eLogger project file : el 04.wez

There is one another “eL._05 project similar to this “eL._03”. Its data format is also REAL. However it
can read or save these process parameters from/to several files.

ISaGRAF project file : el 05.pia

eLogger project file : el 05.wez

This example provides 20 process parameters for controlling the process. These parameter values will
be stored in the “Working_Real.txt” file in the WP-8xx7 ‘s \System_Disk\ directory. The

“Working Real.txt” is a pure text file. It contains 2 rows, each has 10 REAL values. It looks like as the
following.

23,65.9,0.12, 5.87, 88.2,0.34, 8.5, -2.08, 4.08, 5.32
2,-7,6666.8, 456.07,1.01,5,6,7,8,9

The eLogger HMI picture has 20 “Seven Segment” items on the top to display the current working
parameters (Their addresses are 101, 103, 105, ..., 139, the “MouseContrl” properties are set as FALSE
for read-only). And there are other 20 “Seven Segment” items to display and for entering new process
parameters (Their addresses are 201, 203, 205, ..., 239, the “MouseContrl” properties are set as TRUE
for reading and writting).

There are 3 “Switch” items to re-load parameters and re-store parameters and display data is OK or
not. Their addresses are 1, 2, 3 respectively .

eLogger Developer:

Mew Tag | Delete Tag | praling |
Tagz Name Desriptinn Memory Ldd Data T
| | I
Tag ame Dezcription Memory &ddress
4 RE_LOAD Lioad data from file 1
RE_Rtore Store new datato 2
Fead_Data_OK | [TEUE: Data iz rea. .. 3
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E|.= Tag Mapping
Al Tag

ISaGRAF FAQ-115 Version 1.01

NewTog |  Delst Tag [ Sooling |
Tag Name Deszcription Memory Ldd Data Twpe
| I
ezcTipHOn Memory Address Diata Twpe
Warking WAL 0 101 32-bit Float
Working VAL 1 102 32-bit Float
Working ¥AL 2 105 32-bit Float
Working VAL _18 137 32-bit Float
Working VAL 19 139 32-bit Float
THMP_VAL_0 201 33-bit Float
THP ¥4l 1 20z 32-bit Float
TP WAL 2 205 32-bit Float
THP_VAL_18 237 33-bit Float
THP_¥AL_19 239 32-bit Float
ICP DAS
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E ] D 0
IDO Tag vI
o Data Error o
Tag Name Fead_Data_ 0K j
Tag Description | TRTE: Data iz read o D - - |
(Il
Cutput LimdtiMase) 0,000 + Al
Crtpuat Lanit(hdin) .000
B pataPointer S
Address 3 = (C 3.0
AddressType CoilStatus

B DisplayFormat

Caonfirmmindow True

FontSize 14

LedStyle Ellipse
MaouseCantrol False

OffCalor [ | 255, 255, 255
OffDisplayText  Data Error
OffTextCalar B 255,0,0
onCalar [ ] 255, 255, 255
OnDisplayText  Data OK
OnTextCalar M 0.0, 255
WalueTest False

+ :n:' ::..‘: ::l

IDO Tag

|RE_LCI£LD

I*_lLL

ISaGRAF FAQ-115 Version 1.01

Tag Description  [Load data from file
Chatpunt Lamnat(bd i) 0000
Address 1
AddressType CoilStatus
Confirrm®indow True
FontSize 12
_ . MouseCaontrol True
o ] afar 127, 0
: OfDisplayText  RE-LOAD
RE-LOAD o onColar 1 0,255, 0
] .
o & onDisplayText RE-LOAD
YalueTest False
ICP DAS
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Tag Description Bore new data to file
Cnntput Limit(bdin) 0.000
- - B DataPointer
Address 2
AddressType CoilStatus
- - E DisplayFormat
Confirmindow  True
FontSize 12
- - MouseControl True
5 o alar , 127.0
OffDisplayText Apply New VAL
o Apply New VAL & | oncolor [ o, 255,0
o D OnDisplayText  Apply New VAL
YalueTest False

ISaGRAF FAQ-115 Version 1.01

A
|Wu:urkjng_‘i.fAL_D |
eL_US: Se Tag Lwfription
fitput Limit(Ma) 100 |
Chatpat Lavait (b in) -10.0
B DataPointer
Address 101
AddressType HoldingRegister
DataType 32-hitFloat
Eain 1 ﬂ
Offzet 1]
Fange --
T £
Decimal 2
DigitalMumber |7
Fare Colar [ | 0 2550
MouseControl  False ﬂ
Show_Sion True
Testvalue 123.456 2
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Tag Txpe IAO Tag

Tag Mamme IWbﬂﬂng:FEL_IQ

Pagel

R R [

! Tag Description

Output Limnat{hac) 10.0

Onrtput Limdtikdin) -10.0

B DataPointer
Address 1349
AddressType HoldingRegister
DataType A2-hit Float
Gain 1

Offset 1]

Decimal m

DigitalMurmber
Fore Colar [ 0,255,0

MauseCantral False

Data Error

Show_Sign True
Testvalue 123.456 20
B
e H
[ e NN '
+ (C 3ot O =]
|TMP_‘i.FAL_EI j
[ e NN '
L | Q3993
-99893
+ :.:‘ ::_’-: ::‘ E DataPointer
Address 201
AddressType HaoldingRegister
...................................................... DataType 32-hit Float
Eain 1
....................................................... DﬁSEt I:I
Fange --
B DisplayFormat
Decimal 2
DigitalWumber 7
Fare_Caolar 255,0,0
| MouseCaontral True |
Shaow_Sign True
RE-L
I
| L I e o e N a |
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+
r:l:u

RE-LOAD

H
Tag Type IELD Tag vI
Tag Name |TMP_‘.FP.L_19 LI
Tag Description
Cutpnt Limit(bdace) 93394
Cgtput Limit(din) -50000
B DataPointer
Address 2349
AddressType HoldingRegister
DataType 32-hit Float
GFain 1
Offzet 1]
Fange --
B DisplayFormat
Decimal 2
Digitalblumber 7
Fore Colgr 5, 0,0
MouzeControl True
Show_S1gn True
TestWalue 123.456

ISaGRAF FAQ-115 Version 1.01
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[SaGRAF :

Variables: (Please refer to the FAQ-039 to get more information about the ISaGRAF variable array.)

Name Type Attrib. | NetW. Description
Addr.
TMP Boolean | Internal 0
RE LOAD Boolean | Internal 1 Set as TRUE to re-load a File
RE Store Boolean | Internal 2 Set as TRUE to store a File
INIT Boolean | Internal 0 Declare its initial value as TRUE
Read Data OK Boolean | Internal 3 True: data is ok, False: Data error.
Msgl Message | Internal 0 Declare max. len as 128
strl Message | Internal 0 Declare max. len as 255
TMP _file name Message | Internal 0 Declare max. len as 128
Filel Integer Internal 0

—_
()
—_

Working Real. VAL[0..19]| REAL Internal The 20 process working parameters.
variable array, Dim = 20

Declare its 1st Addr. as 101

TMP_Real VAL[O0..19] REAL Internal 201 variable array, Dim = 20.
Declare its 1st Addr. as 201

NUMI Integer Internal 0
i Integer Internal 0 Index of “for” loops
1] Integer Internal 0 Index of “for” loops
Data Cnt Integer Internal 0
Row_ Cnt Integer Internal 0 The row amount, set as 2
Data Cnt in Row Integer Internal 0 The data amount in each row,

Setas 10

Project :

-=_[5aGRAF - EL._03 - Programs - | I:Ilil
File Make Project Tool: Debmg Ophons:  Help

D EeE DEn (S| ok i

Begin: YIEL LR Fead data from = file

Savel =zave datatoafie
fret otherl Do user logic when Resd_Dsta_ok is TRUE

Begin: Load! (Structured Text)
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Program — Loadl :

(* Operations in the first PLC Scan *)
if INIT then

(* Assign Network addr for Array Variable *)

(* assign Working Real VAL[ ]Jas 101,103, 105, ..., 139 *)
TMP :=S MB_ADR(101,20,1);

(* assign TMP_Real VAL] ]as 201, 203, 205, ..., 239 *)
TMP :=S_ MB_ADR(201,20,1);

(* file name which stores the current working parameters *)
TMP_file_ name := "\System_Disk\Working_ Real.txt' ;
RE_LOAD :=True; (* trigger to read data from file when PLC is started *)

end if;

(* if RE_LOAD is TRUE, Open one file and read it *)
if RE_ LOAD then

RE_LOAD := FALSE ; (* Resetas FALSE *)
Read Data ok := False ; (* set data error at the beginning *)
Data_Cnt :=0; (* set as no data read at the beginning *)
Filel :=f wopen( TMP_file name ) ; (* Try to open file in Read & Write mode *)
if Filel =0 then
(* Open error, exit this ST program to run next program *)
Msgl := 'Can not Open file ' + TMP_file name ;
INIT := False ; (* reset it before exit this ST program *)
return ;

end if ;

(* max 2 rows to read these 20 REAL values, Each row in the file contains 10 REAL values *)
for ii := 0 to (Row_Cnt-1) do

if f eof(Filel) = TRUE then (* testif End Of File reached *)
(* Reach End Of File *)
Msgl := 'There should be at least ' + MSG(Row_Cnt)+ ' rows in ' +TMP_file name+'!!!";

exit ; (* exit for loop *)

end_if ;
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strl := fm_read(Filel) ; (* Read one row as String (message) *)

(* Convert this string to some REAL values and store them into No.1 Float array *)
NUMI1 := Msg F(strl,1);

if NUM1 <> Data_Cnt_in_Row then (* there should be 10 REAL values in each row *)

(* error, it means the message is not correct REAL values or data number is not enough *)

Msgl := 'The data format of No.' + Msg(ii + 1)+ ' row is not correct or data number is
not ' + MSG( Data_Cnt_in_Row) ;

exit ; (* exit for loop *)

end_if;
Data_Cnt := Data_Cnt + Data_Cnt_in_Row; (* ok ! Data Cnt plus Data Cnt in_Row *)

(* conversion Ok, store these 10 REAL values to TMP_Real VAL[ ] *)
for jj := 0 to (Data_Cnt_in_Row-1) do
(* Get these converted REAL values from No.1 Float array 's addr. 1 to 10 *)
TMP_Real. VAL| Data_Cnt_in_Row *ii+jj] := ARY_F R(1,jj+1);
end for ;

end_for ;

(* Any file been open should be closed by f close( ) *)
TMP :=f close(Filel) ;

(* All data are read Ok *)

if (Data_Cnt=Row_Cnt * Data Cnt_in_Row ) then
Msgl :="'Read ' + TMP_file name +' Ok ';
Read Data Ok :=True ; (* set as read OK *)

(* 1f this scan is the first scan, store TMP Real Val[] to Working Real. Val[] *)
if INIT then
for ii :=0 to (Data Cnt-1) do
Working Real._VALii] := TMP_Real._VALIii] ;
end_for ;
end_if ;

end _if ;
end_if ;

INIT := False ; (* No more first PLC scan *)
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Program — Savel :

(* Store data to a file when RE_Store is True *)
(* This "RE_Store" can be triggered by eLogger HMI *)
if RE_ Store then

RE_Store := False ; (* reset it *)
Read_Data_ok := False ; (* set data error at the beginning *)
Data_Cnt := 0 ; (* set as no data read at the beginning *)

TMP :=f delete( TMP_file name ) ; (* delete file first and then create and write it *)

(* creat a new file *)
Filel :=f creat( TMP_file_ name ) ;

(* Creat failed, exit this ST program *)

if Filel =0 then
MSGT1 :="Can not Create a new file - ' + TMP_file name +'!';
return ; (* exit this ST program *)

end_if ;

(* max 2 rows to save these 20 REAL values, Each row in the file contains 10 REAL values *)
for ii := 0 to (Row Cnt-1) do

strl :=""; (* set as an empty string at the beginning *)

(* There is 10 data in one row *)
for jj:=0 to (Data_Cnt_in_Row-2) do
strl :=strl + Real Str( TMP_Real. VAL[Data Cnt _in_Row *ii+jj])+"',';
end_for ;
(* add last data of this row to strl *)
strl := str1 + Real_Str( TMP_Real._VAL[Data_Cnt_in_Row * ii + jj] ) + 'SODS0A"' ;

(* write this row to file *)
TMP :=F writ_S( Filel , strl) ;
if TMP = False then
MSGT1 :="Write data to file - ' + TMP_file name + ' failed !' ;
exit ; (* exit this for loops *)
end if;
Data_Cnt := Data_Cnt + Data_Cnt_in_Row; (* ok ! Data Cnt plus Data Cnt in Row *)

end_for ;
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TMP :=f close(Filel) ; (* Any file been open should be closed by f close() *)

(* All data are saved Ok *)

if (Data_Cnt=Row_Cnt * Data Cnt_in_Row ) then
Msgl :="'Write ' + TMP_file name +' Ok ';
Read Data ok :=True ; (* set data Ok *)

(* Store TMP_Real Val[] to Working RealL Val[] *)
for ii :=0 to (Data_Cnt-1) do

Working_Real. VALYii] := TMP_Real._VALii] ;
end_for ;

end_if ;

end_if ;

Program - Otherl :

*if Read_Data_0K is False, that rmeans the process parameter "Working_Real VALY is not ready. Then return. )

Read_Data_0kK

I 11

* If Read_Data_0K is True, thenyou can use "Working_Real _VAL[]" inyour Lodic below. ... ™)
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How to test ?

User may click some “Seven Segment” items in the “NEW VAL” area to enter some different values.
Then click the “Apply New VAL” and set as ON to apply the new value to become the working
parameters. You will see value be changed in the “Working VAL” area. If connecting PC / ISaGRAF
to the WP-8xx7 controller, you will find the related value of the ISaGRAF variable be changed too.

Then reset the WP-8xx7 controller once. You will also find the parameter values in the “Working

VAL” area now are the new values after re-start the controller .

el_03: Section 1.5.2 in FAQ-115
Working VAL 01 ~ 20
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1.5.3: Read And Modify The Date / Time And Doing Some Control

ISaGRAF project file : el 06.pia
eLogger project file : el 06.wez

This example can read and then disply the current date and time of the controller, and can modify it to
be a new date and time. This example also outputs “OUT1” as ON at 09:00 to 18:00 on Monday to
Friday, while outputs “OUT2” as ON at 09:00 to 12:00 on saturday and Sunday.

eLogger Developer:

..... £ DI Tag

NewTsg |  Debe Tag [ e |
Tagz Name Diezcription Memory Ldd Data Ty
ISet_Tims ISet az Wew Date £ Time I 101 |

Tag Wame Diezcription Memorr &ddress
[ et Time | :SetasNewDate/ .. 101
Refresh_Time | |Eefresh as Curpen... ﬂ
Elﬁ Page(Mew)
P B Pagel New Tag | Delete Tag | Braling |
Tag Wame Diescription Memory 4dd Data Type
Set_Time ISet as New Date ! Time I 101 | |
Tagz Name Diezcription Memory &ddress | Diata Twpe (3

Tearl 1 16-bit Zigned Tnte...

Monthl 2 16-bit Zigned Tnte...

Dyl 3 16-bit Signed Tnte. ..

Hourl 4 16-bit Signed Dnte...

Minute1 5 16-bit Figned Inte. ..

Second 1 6 16-bit Zigned Tnte...

W _Yearl 11 16-bit Zigned Tnte...

W _Monthl 12 16-bit Signed Dnte...

W _Diayl 13 16-bit Bigned Dnte...

W _Hourl 14 16-bit Figned Inte. ..

W _binntel 15 16-bit Zigned Tnte...

W_Zecondl ] 16-bit Zigned Tnte...
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‘ d ~
06: Section1.5.3inFA

ant Day /M

and

lew Day / Month / Year anc

N
L

Output Limit(Min)

Chatpnt Lamit(hdas)

33T

-33768

B DataPointer
Address

DataType
Gain
Offzet
Range

AddressType

K]

HoldingRegister
16-hit Signed Integer
1

1]

-32TREB.000~3276ET.000]
B DisplayFormat

Decimal 0
- ,\"- / - DigitalMumber | 2
Fore_Color 0, 255,0
Mnus-eCuntrnl mse
efresh as Current Date / tim| | show_sign False
- — ] Tostvanie 173,450
T— |
a _!:I i Tag Tvpe L0 Tag -
Tag N I'fes:rl ;I
Tag Despfiption
i: Section 1.5.3in FAQ-11 oypuf it 37767
tput Limit(in -32768
= DataPointer
Day / Month / Year dlm . ;
] AddressType HaldingRegister
DataType 16-hit Signed Integer
Fain 1
Offset 1]
| Day IMonth f Year anc FRange -327EB.000~32767.00(0
B DisplayFormat
Decimal 0
o/ R Lo
Fare_Caolor 0, 255,0
Muus-eCnntrul False
esh as Current Date /tim|| show_sign False
__________________________| _TESt"l.l"alLIE 123.456
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L

16: Section 1.5.3in FAQ-11 gupuifmiteda

t Day /Month / Year arfd |~ Dtapomter

B/

w Day / Mobnth / Year anc

Tag Type 40 Tag -
TagName | |W_Dayl |
Tag Desoripdion
30

ut Linmit(kdin 100
Address 13
AddressType HoldingRegister
DataType 16-hit Signed Integer
Gain 1
Offzet 1]
Range -32TRB.000~3276ET.000]

fresh as Current Date /tim
‘ r oM
4 -~ .

ant Day / Month / Year and
aaflaap) 7

lew Day / Month / Year

Ll JE

efresh as Current Date /tim
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Decimal 0
Digitalumber 2

Fore olar [ 0, 255, 0
MouseContral True

Show Sidgn False
Testalue 123.456

CrataType
Gain
Offset
Fange

11
HoldingRegister
16-hit Signed Integer
1

1]

-32TAEE.000~32767.000

= DisplayFormat

Decimal 0
DigitalMumber 4
Fore_Caolar L] 02550
MDUS-ECDntrDI True
Show_Sign False
Testvalle 123.456
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elL_06: Section 1.5.3in FAQ-115 x|
Current Day /Month / Year and Time s o b T
0.oon
NN M
Crtpat Lavadt (b i) 0.oon
B DataPointer
: Address 102
Set New Day /Month / Year and Tim AddressTys  [Colsmis
m J.tm J.t m Confirrmtindow  False
FontSize 14
n] | & | MouseControl True
o _Refresh as Current Date /time o ool 01270
= OfDisplayText Refresh as Current Da
0 . oncolor [T 0, 255, 0
OnDisplayText
ValueTest False
Time
Chatput Limdt(hda) 0.000 \ :
Cmtput Limdt(bdin 0.000 \
g \E DataPointer B Time
Address 101
AddressType Coilstatus
B DisplayFormat : m :m
{ confirmiwindow True |
Fontsize 19 g o a
I WouseCaontral  True e o SetDate/Time o
| ﬁm“nlnr 197 0 [ D — D
OfDisplayText Set Date / Time -
cncalar ] 0, 255, 0
OnDisplayText  Set Date / Time
WalueTest False
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ISaGRAF:

Variables:
Name Type Attrib. | NetW. Description
Addr.
Set_time Boolean | Internal 101 Set True to modify to new time
Refresh Time Boolean | Internal 102 Set True to refresh to current time
OUTI Boolean Output 0 Link to [-87055W 's CH.1
OouT2 Boolean Output 0 Link to I-87055W 's CH.2
time val Integer Internal 0 Unit is minute
0~ 1439 means 00:00 ~ 23:59
Yearl Integer Internal 1 Get Year
Monthl Integer Internal 2 Get Month
Dayl Integer Internal 3 Get day of Month
Hourl Integer Internal 4 Get Hour
Minutel Integer Internal 5 Get Minute
Secondl Integer Internal 6 Get Second
WeekDay1 Integer Internal 0 Get Weekday
W _Yearl Integer Internal 11 New Year
W_Monthl Integer Internal 12 New Month
W_Dayl Integer Internal 13 New Day
W _Hourl Integer Internal 14 New Hour
W_Minutel Integer Internal 15 New Minute
W_Secondl Integer Internal 16 New Second
Project :
i

File Make Pmject Tool: Debng Options Help
B HSE DED * X ni22s

Biegin:

5T

Begin: LD1 (Ladder Diagram]
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Program - LD1 :

SYS0AT_R
En eno

YY_

hhA_

oD

WY

—eart

—fanth

_FDav

RALEEANET

Set_time

SYSTIM_R
En eno

HH_

hthd _

o0

—Hourl

—linte 1

—Second]

S EDAT_W

Set_time
T

Wi vear!t Y

IM_ Q

W _Month 1 —hihi_

Wi Dranl

SYETIM_WY
Q

In_

W_hourfHH_

Wi_minute1— i _

W_second1 133
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Program - ST1:

(* Unit is second, 0~ 86399
Time val := 3600 * Hourl + 60* Minutel + Second] ;

*)

(* Unit is minute, 0 ~ 1439 *)
Time_val := 60 * Hour1 + Minutel ;

OUT1 := False ; (* set as False first *)
OUT?2 :=False ;

(* set OUTT as True at 9:00 to 18:00 on Monday to Friday *)
if (WeekDay1>=1) and (WeekDay1<6) and

(Time_val >= 540) and (Time_val <1080) then

OUT1 :=True ;
end_if ;

(* set OUT2 as True at 9:00 to 12:00 on Saturday and Sunday *)
if (WeekDay1=6) and (WeekDay1=7) and

(Time_val >= 540) and (Time_val <720) then

OUT2 :=True ;
end_if ;

(* Refresh to Current date and time *)
if Refresh_Time then
Refresh_Time := False ; (* reset as False *)
W _Yearl := Yearl ;
W_Monthl := Monthl ;
W_Dayl :=Dayl ;
W_Hourl1 := Hourl ;
W_Minutel := Minutel ;
W_Secondl1 := Secondl1 ;
end_if ;

ISaGRAF FAQ-115 Version 1.01 ICP DAS



I/0 Connection:
- -I3aGRAF - TIME3 - Programs -0l x|
File Make Project Tools Debug Ophons Help
B HSE DED| S Xis @k 2as |

Bedgin: [y LD

wn ISaGRAF - TIME3 - I/0 connection _||:|

_ File Edit Tool: Options Help
SIS A=

[o] «| v ref = 870558

m i_87055 o QUTT [ link to siot 1 : 1-87055%'s Ch.1 %)
[-] = DIB ne @ QUT2[ link to slot 1 : 1-87055%'s Ch.2 %)
. = D08 o Il |i| #]

N (2] 7l

- (5 4

How to test ?

Click and set a new date and time and then click “Set Date / Time” button and set it as ON to
implement the new date and time .

el_06: Section 1.5.3 in FAQ-115

Current Day f Month f Year and Time

B/ B E E:E
Set New Day f Month f Year and Time

EE /N R, EE m\n

Refresh as Current Date [ time Set Date f Time ~
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